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Introduction

SureSync is a powerful file replication & synchronization utility that can be used to ensure users
on your network are always working off of the most recent version of critical files, for disaster
recovery purposes, for software distribution, and much more. When the ArchiveSync Add-On is
licensed, you can also generate versioned backups to devices such as a removable USB hard
drive, a NAS, or a SAN. This allows you to protect your critical files automatically, restore to
various points in time, and restore files much quicker than possible with traditional methods of
backup.

This evaluator’s guide is designed to walk you through the initial setup of SureSync with the

ArchiveSync Add-On. ArchiveSync jobs can be run in both scheduled and real-time modes of
operation. This guide will focus on real-time data protection.

System Requirements

SureSync’s basic operating system and hardware requirements are:

e Supported Operating Systems: Windows Server 2008 R2; Windows Server 2008;
Windows Server 2003; Windows Server 2003 R2; Windows Vista; Windows XP;
Windows 7

e Processor: 400Mhz Pentium Processor or equivalent (Minimum); 1Ghz Pentium
Processor or equivalent (Recommended)

e RAM (total for system): 256MB (Minimum); 1GB (Recommended)

e Hard Disk: 30MB for application files; 20MB+ for database

o Display: 800x600, 256 colors (Minimum); 1024x768 high color, 32-bit (Recommended)

SureSync can synchronize data to machines running operating systems such as Windows 95,
Windows 98, Windows NT 4.0, Windows 2000, and non-Windows machines such as Macintosh
and Linux via UNC path but the software itself must be installed on one of the supported
operating systems listed above.

SureSync requires a database which is used to store configuration information. The following
formats are supported:

e Microsoft Access (default)
e MSDE 2000 / SQL Express 2005 / SQL Express 2008
e SQL Server 2000/ SQL Server 2005 / SQL Server 2008

To achieve optimal performance, a SQL database is strongly recommended for setups using
multi-directional Rule types, environments with more than 50 Relations defined, or environments
where hundreds of thousands of files will be processed.

SureSync requires a number of Microsoft components to be installed on the system. The
SureSync installer will detect the versions your system is running and upgrade them as needed.

Microsoft .NET Framework 3.5 with Service Pack 1
Microsoft MDAC 2.8 Refresh with Service Pack 1
Microsoft Visual C++ Runtime 9.0 with Service Pack 1
Microsoft Windows Installer 3.1

Microsoft XML Parser 6.0

Microsoft Jet 4.0 with Service Pack 8
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Contact Information

If you need further information about SureSync or need clarification on anything within this guide,
please contact our support group and they will be happy to assist you with your evaluation.

Software Pursuits, Inc.
1900 South Norfolk Street, Suite 330
San Mateo, CA 94403

Phone: +1-650-372-0900
Fax: +1-650-372-2912

Sales e-mail: sales@softwarepursuits.com
Support e-mail: support@softwarepursuits.com

Required Add-Ons for ArchiveSync in Real-Time

SPIAgent Add-On

The SPIAgent is a powerful Add-On license for SureSync, which contains a number of
performance enhancing features. This license is required to perform File Locking.

e Real-Time Monitors
Real-time replication increases data availability by continuously monitoring data for
updates. By copying files immediately after they change, SureSync can avoid folder
scans that are necessary for scheduled jobs.
e Adaptive Delta Technology
SureSync copies only the changes made to a file, reducing synchronization time and
decreasing the consumption of network resources.
o0 Delta Processing to Non-Windows Machines
If you map a non-Windows drive to a drive letter on a Windows machine you can
process delta copies to that non-Windows machine. This in turn provides
bandwidth savings between any machines, regardless of the OS.
o File Compression
Transmit files in a smaller package across your network by compressing them. File
compression is particularly useful on slow network connections. SureSync also allows
you to specify the level of compression to control the impact on your system.
e TCP/IP Transmissions
Transmissions across the Internet give you more options on how you connect to remote
machines. Now it is even easier to keep office branches connected to the information
they need.
e Encryption
Ensure your files are being transmitted securely by utilizing the option to encrypt each file
transmission. This is an especially useful and necessary tool when transmitting sensitive
data across the Internet.
e Change Journal Support for Schedules
When a Schedule is configured to run a Relation using the SPIAgent Add-On, SureSync
utilizes the NTFS Change Journal, which minimizes the amount of scanning a
synchronization job must perform. Eliminating much of the scanning creates a significant
performance improvement for Schedules.
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ArchiveSync Add-On

SureSync’s ArchiveSync Add-On allows users to create versioned backup copies of files,
providing an efficient disk-to-disk backup solution. Versioned file copies allow users to quickly
restore files to a specified point-in-time, without sifting through tape backups. Additionally, when
archiving or restoring, the ArchiveSync Add-On will allow you to backup and restore security
privileges as well.

Archiving can be done in real-time to continuously protect data, effectively eliminating tight

backup windows during the evening. ArchiveSync will also automatically thin out your archive to
clean storage up.

Other SureSync Add-Ons

Software Pursuits also offers additional Add-On products for SureSync which provide additional
functionality. The available Add-On products include:

SPIAgent File Locking Add-On

The SPIAgent File Locking Add-On requires the SPIAgent to be licensed and in turn gives you an
additional benefit in file sharing environments. The SPIAgent File Locking Add-On eliminates the
possibility that a file could be changed on multiple sides of a synchronization, resulting in a more
efficient synchronization with zero risk of lost changes. A user who attempts to open a file that is
already in use will receive an indication from the application that the file is locked.

Please consult the SureSync with SPIAgent File Locking Add-On Evaluator’'s Guide for further
details.

Commonly Asked Questions

What is an Interval?

Understanding the concept of an Interval is essential to configuring ArchiveSync properly. An
Interval is simply a period of time. You will configure a set of Intervals to tell ArchiveSync how
many versions of a file you wish to keep in those different periods of time.

1/4/2010 - 110/2010
Total for Archive Rule 13 Copies

( 8 \
i i
V1412010 - 1/6/2010 1/8/2010 - 1/10/2010
|
2 Day Interval - 8 Copies 1 Week Interval - 5 Copies
: D ) ) ] ) :
|
1/5/2010 1/6/2010 1/7/2010 1/8/2010 1/9/2010
1/4/2010 11102010

The most important thing to understand about Intervals is that they all start at the same point in
time. Consider the example timeline above which shows a week (7 days) of time. In this example,
two Intervals have been defined. The first Interval is defined as 2 days with 8 copies stored in the
archive. The second Interval is defined as 1 week with 5 copies. Note that the 1 week Interval
covers the period after the 2 day interval. These two Intervals result in 13 copies in the week.
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From what starting time is an Interval calculated?

An ArchiveSync Interval is calculated differently depending on the way that the Relation is being
run. If you are running a Relation on a scheduled basis, the Interval is calculated from the time
that the Schedule starts to run. If you are running the Relation on a real-time basis, then the
Interval is calculated from the time a file changes.

How does ArchiveSync determine which copies to keep in an Archive?

ArchiveSync will spread the number of versions out as evenly as possible throughout an Interval.
For example, if you have an Interval defined to keep 7 versions in a week then ArchiveSync will
try and space out the versions in the Archive so that they are as close to a copy a day as
possible. Older versions fall into the next Interval. If you had a second Interval asking for 3
versions in a month then ArchiveSync would try and keep a version a week for the remaining
three weeks of the month.

Example Archive Rules

Understanding how to construct Archive Rules is an essential part of using ArchiveSync to protect
your files. The Archive Rules are extremely flexible and allow you to protect data in a variety of
different ways.

This section of the guide will present some example Archive Rules to assist you in determining
the type of Rule construction you will want to use to protect your data. You have a lot of flexibility
when defining Archive Rules which allows ArchiveSync to protect a particular data set in just
about any way you desire.

Normal Documents

A balanced Archive Rule that will maintain versions for 3 years before thinning versions out of the
Archive. This Rule keeps more copies when the file is newer and then just a few over the time
past a week.

- —
. -_— E=nLE
SR el WS

Archive Fule Name  |[{lsiEINRTe =l H

[ Mew Rule... ] ’ Delete Rule l ’ Rename Rule... ]

Interval Age Max Versions [M]
3 Years 3 Delete Interval
1 Weeks 5 —
1days 3 Edit Interval...

3| Recent versions to kesp

30| Days to retain sole version
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3 Year Documents

This Archive Rule also stores files for 3 years, but you will notice how the copies are more spread
out by having the 6 copies in 3 months Interval added.

ooere Wl i

Archive Rule Name |8 (== 00T LTS v |

Mew Bule... ] ’ Delete Rule ] [ Rename Rule... ]

rterval Age Vi Versors nbictiotenpt |
3 Years kS

3 Months 6 Delete Interval
o :

2| Recent versions to kesp

50| Days to retain sole version

7 Year Documents

The 7 Year Documents Archive Rule is a recommended example for longer term storage of
critical files. This is a variation of the 3 Year Documents Rule that expands the time stored in the
Archive to 7 years. This Rule maintains fewer copies early in the file lifespan.

Archive Rule Name |8 (== 00T TS v |

’ Mew Bule... ] ’ Delete Rule ] [ Rename Rule... ]

Interval Age Max Versions New Interval ..

7 Years 4

3 Months 5 Delete Interval
Hlesss ’

2| Recent versions to kesp

50| Days to retain sole version

Temporary Files

This Archive Rule is useful in protecting files that are not needed long-term. For example,
employees may work on files in one location and transfer final documents to another location for
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long-term storage. In these cases, you want to protect the temporary work files but not have them
maintained for long periods in the Archive. This Rule works perfectly for those types of scenarios.

-

-
E Archive Rule o (S

Archive Rule Name [0 = vl = H

’ Mew Rule... ] ’ Delete Rule ] [ Rename Rule... ]

Interval Age Max Versions New Interval...

1d 3
e Delete Interval
Edit Interval...

1| Recent versions to keep

1| Days to retain sole version

Our Scenario

This guide will walk you through the configuration of SureSync using the ArchiveSync Add-On to
protect your files in real-time as changes occur. To use a Real-Time Monitor to archive files, all
machines involved must be running supported Windows operating systems. ArchiveSync can
generate versioned backups to multiple destinations from a single job. In this scenario, we will be
protecting a folder on a machine named JEFFK-HP and creating an archive that is maintained in
real-time on a machine named JEFFTEST. The folder for this example scenario is C:\SalesData
on the JEFFK-HP machine.

While this guide will show you how to run an archive job in a Real-Time
Monitor, you can use the exact same steps to configure the archive job
in a Schedule. The only difference is you would create a Schedule
instead of a Real-Time Monitor. The rest of the configuration is identical.

Schedules can also be used to archive data via UNC path from
machines which do not support the installation of the SPIAgent Add-on.
This is useful for archiving from old Windows machines and non-
Windows machines such as Linux based NAS devices.

JEFFK-HP JEFFTEST

%
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Installation

To begin your SureSync trial, you must install the correct SureSync components on the right
machines. SureSync is installed using a Windows Installer (MSI) driven installation application.
SureSync and all Add-On products are installed using the same installer.

For this scenario, the full SureSync application will be installed on one machine (JEFFK-HP) and
the SPIAgent will be installed on the other machines (JEFFTEST) as illustrated below.

JEFFK-HP JEFFTEST

4"

SureSync Eﬂ SPlAgent

On the JEFFK-HP machine, we will run SureSyncSetup.exe and select SureSync as the
installation type in the installer. This will install the complete SureSync application and make
JEFFK-HP the machine where we configure and run our archive job.

E SureSync - InstallAware Wizard E@g

Software Pursuits, Inc.

g SureSy chSEtUp"

Select an installation type:

& full SureSync application uzed to configure
and run spnchronization and replication jobs.

() SureSync with SPIAgent File Locking
Inztalls the full SureSync application and the components
required for the SPlAgent File Locking Add-on.

Il () SPIAgent
I Inztalls the SPlAgent service anly.

(7} SPIAgent with SPIAgent File Locking Product install path:
Installs the SPlAgent service and the components C:\Program FileshS oftwane Pursuits\SureSync Browse...
i required for the SPlAgent File Locking Add-on. =

Installaware [<Erevious ]I Mext > |[ Cancel ]

On the JEFFTEST machine, the SPIAgent only installation should be performed. This is
accomplished by launching SureSyncSetup.exe on that machine and selecting “SPIAgent” as the
installation type.

Software Pursuits, Inc. 8
www.SoftwarePursuits.com




Launch SureSync for the First Time

Now that all of the required components have been installed on the machines that will be involved
in the archive job, we can continue with the configuration. To launch SureSync for the first time,
go to the Start menu, select the SureSync folder and click on the SureSync icon. This will launch
the SureSync desktop application, where you will perform all of your archive job configuration. On
the first launch of the application, SureSync will create an Access database to store your
configuration information.

The default database format for SureSync is Microsoft Access.
SureSync also supports Microsoft SQL and this database format is
recommended for environments running many multi-way Rules or a
large number of jobs to achieve optimal performance. Please refer to the
Upgrading from an Access to SQL Database knowledge base topic for
more information.

Once the database has been created and the SureSync desktop has loaded, you may proceed
with your configuration.

Installing the SureSync Scheduler

The SureSync Scheduler is a Windows service that runs on the main SureSync machine. This
service is responsible for launching Schedules at the correct times and for running Real-Time
Monitors. You must have a Scheduler running in order for your Real-Time Monitor to start.

To install the SureSync Scheduler service, go to the Tools menu within SureSync and select
“Schedulers...,” which will launch a window like the one below.

= .|
% Scheduler Servers — &J
Scheduler Service on this machine
Identify the servers to run the Scheduler Service. You may start or stop the
Scheduler Service from this form.
| D Add
Remove

To install the Scheduler, click the “Install” button, which will launch a window like the one below.
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-
ﬁ Scheduler Service Logon Ing rmation _‘ﬁ

User Id [<domainz=\<useridz=]

domain'user
Cancel

Conrfim Password

1

You are about to install the Scheduler Service on your cument
machine. Please specify the user name to use for this service in
the format

<domain name>"<user name:>

or <computer names'\<user name. You may specify \<user
name:for an account on the local machine.

The account you specify must be a member of the Administrators
group far your machine.

Enter the username formatted as machinename\username or domainname\username. This
account must be an administrator on the machine. Click “OK” to install the service.

Scheduler Service on this machine

Install Uninstall

|dertify the servers to run the Scheduler Service. You may start or stop the
Scheduler Service from this form.

d';‘BPGGCG 1-JEFFK {(Running} Remove

Start Stop Fause

Once the service has been installed, click on the machine name and click “Start.” The Scheduler
will now be listed as Machine Name (Running).

Configuring the SPIAgent Machines

The next step in the configuration is to define the remote SPIAgent machines in SureSync. To do
this, launch SureSync, click on the “Tools” menu, and then select “SPIAgent Setup.”

Software Pursuits, Inc. 10
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3
SPIAgent Settings and Computer References =NECN X

SPlAgent Corfiguration

[] Run the SPIAgent Service on this computer

This machine has not yet been evaluated for the license needed.

Select a computer from the list to edit its settings. _z‘

Deploy Updates...

Default =Use default

"

Close

Select the SPIAgent from the drop down menu to begin configuring it. If the agent you want to
configure does not appear in the list, you may enter a name for it by selecting "Add New
Machine" from the drop down menu.

The machine name listed in the "Select a computer from this list to edit
its settings" drop down menu must be the actual machine name for the
machine you're trying to connect to. Using an IP address or a random
name in the drop down menu will result in the test failing.

You will then want to:

=

Check the box that says "Run the SPIAgent Service on this computer.”

Enter the IP address or DNS name for the machine running this SPIAgent into the "Agent
IP or DNS Name" field.

Enter a username with adequate permissions to that machine in the “Default User ID”
field. We recommend a domain administrator account. Be sure to configure the account
as domain\user. If you wish to use a local account on that computer, it can be formatted
as machinenamel\user.

Enter the password for the account in the "Default Password" field.

Make sure the user account specified here has "log on as batch job" rights on the
machine in question.

Click save and then test to verify the configuration.

The “log on as batch job” right can be assigned by going to the Start
Menu, selecting Administrative Tools, and then Local Security Policy.
Under User Rights Assignment you will find the “log on as batch job”
right. On domain controllers, you must use the Domain Controller
Security Policy applet because they do not have Local Security Policy
available.

These steps should be done for each remote SPIAgent in question. In the example scenario,
JEFFTEST would be defined. An example of a completed SPIAgent configuration is shown in the
screenshot below.
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r 1
[B] sPiagent Settings and Computer References EI_Iﬂ—hJ

Workstation (Windows XP or later) Version 5.1
SPlAgent Configuration
Run the SPlAgent Service on this computer
Agent IP or DNS Name [JEFFTEST
Agent's TCP Listen Port  |{Default) | O=Use default
Default User ID (Domain“\User) |[domain‘user
Default Password

Deploy Updates...
Check trace options below only if instructed by Technical Support
[ TraceC ] Trace K
] Trace S ] Trace D [ Wwirap Traces

This machine is a8 workstation and requires an agent license. This machine can be accessed with
any licensed version of SureSync.
The User |D entered must have log on as a batch job’ rights for this workstation.

Select a computer from the list to edi its settings. | JEFFTEST lz‘

Test Cancel ] [ Save

Creating the Relation

Relations are the basic building blocks of the SureSync application. Each Relation contains the

root paths (source and destination paths) that apply to that Relation and options for the Relation.

Each Relation also contains one or more Rules, which tell SureSync how to archive the data in
guestion. The Relation and the Rule are created together in one wizard.

has been created.

The wizards are designed to quickly and easily configure the basic
options needed to get a Relation up and running. SureSync is an
extremely flexible product with many advanced options. Additional
options can be specified on the properties panels for the Relation after it

To create your Relation, launch SureSync and then go to the "File" menu and select "New" and

"Relation”.

Name Your Relation

Software Pursuits, Inc.
www.SoftwarePursuits.com

12



3 Relation Wizard ! = e

Relation Name

Relations are used to build jobs, such as Schedules and Manitors. A Relation defines
the relationship between folders that are to be synchronized or replicated. Each Relation
must have a unique name. This wizard will set basic properties. You can set advanced
options later using properties displayed on the main form.

What do you want to call this Relation?
Archive to JEFFTEST

Describe this Relation (optional)

The first panel in the wizard allows you to name your Relation. Enter the name of the Relation

and an optional description and click “Next” to continue. The Relation name used for this example
will be “Archive to JEFFTEST".

Specifying Root Paths

The next panel is used to specify the source path and the archive path(s) for the archive job.
Later in the wizard, you will specify which path is source and which is destination. In this dialog

box you are simply listing the paths, both source and destination, that will be part of this archive
job.

There must be at least two root paths specified (a source and a
destination) to have all Rule types available. Later on in the wizard you
will get to specify which path is source and which is destination. If you

specify only one path, then the only Rule methods available later in the
wizard will be “delete” and “skip”.

[ Relation Wizard P T

Root Paths

Specify the source and destination roat folders for this Relation. The direction of your
copying is determined by your Rules, which will be created shortly.

Agent Name Path Relative to Agent

[fdd. ) [ Edt. | [ Remove |

[ Cancel ] [ < Back ][ Next =

Software Pursuits, Inc. 13
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Root paths are added by clicking the “Add” button at the bottom of the panel to display the “Select

a new root path” panel shown below.
For this example, our root paths are:

e C:\SalesData on JEFFK-HP

e C:\SalesDataArchive on JEFFTEST (the location of the archive)

First, we will select the local path on JEFFK-HP by browsing to that path through “My Computer”,

highlighting the directory and clicking “OK.

~
[2] Select 2 New Root Path I=RECAL X
/ Path | Options
Path will be accessed via this SPIAgent
(Local Agent/iNo Agent) E
$Recycle Bin -

Documents and Settings
Downloads

hp

Intel

MS0Cache

m

My RoboForm Data

PerfLogs

Program Files

Program Files (x86)
ProgramData

SourceSafe

SureSync € Performance Tests
SureSync Test Folders
System Volume Information
Traces

Users -

- - B - B BB

Roct Folder

C\SalesData

The Root Paths panel will now look like the screenshot below. Click “Add” to add the path for the

remote machine.

[ Relation Wizard = X

Root Paths

Specify the source and destination roct folders for this Relation. The direction of your

copying is determined by your Rules, which will be created shortly.

Agent Name Path Relative to Agent

[Local Agert] {New} C\SalesData
[ &dd ) [ Edit. | [ Remowe |
[ Cancel |[ <Back |[ New> |

On the “Select a New Root Path” panel, you will select the machine name from the “Path will be

accessed via this SPIAgent” drop-down menu, browse to the path, and then click “OK”.
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When selecting a remote SPIAgent from the drop-down, the browse
panel will display the drives and folders from that remote machine as if
you were sitting down in front of the computer.

B Select a New Root Path . N 0 o
/" Path | Options-[ SPlAges

Path will be accessed via this SP1Agent

JEFFTEST [=]
[=H_] Lecal Disk (C:) -
L AP i |
] DELL

| Documents and Settings
[_] FileLockingTest

[_] MigratePro Test Folders
|__1 Mirror

|__] Program Files

[_] Projects

| PsTodls

] ResumeTestDestination
| <cesDtaivcve

| SureSync Performance Tests
[_] SureSync Test Folders
(] Test

|_] TindallDest

[_] Traces

[_] WINDOWS

m

Root Folder

CiSalesDatalrchive |

After selecting the path, click on the “Options” tab and check the “This is an Archive Root Path”
option to tell SureSync that this path is the path where the Archive should be stored.

B Select a New Root Path . N 0 o

[ Create roct folder if it does not exist

Convert path to UNC format, if possible
Allow copying security objects to this path
Verify volume changes when history is used |

[] Copy "Date Created” and Access Date for files copied to this path

Monitor folder for content changes

User Id for FTP or Path Access (not for SPIAgent)

Change.
FTP Profile
(None) E|
Dial-p Connection used by this Path
(no connection) [=]

ction when Relation is complete (unless connection was previously

Click “OK” to add the path. On the Root Paths panel, note that the Archive path is now
represented with a special icon.
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[ Relation Wizard =l
Root Paths
Specify the source and destination root folders forthis Relation. The direction of your
copying is determined by your Rules, which will be created shortly.
Agent Name Path Relative to Agent
[Local Agent] {New} C:\SalesData
(SIJEFFTEST {New} C:\SalesDataArchive
[Thdd, | [ Edt. | [ Remove |
[ Cancel ][ <Back ][ Next> |

Once all of the paths have been entered, press the “Next” button to continue.

Selecting Your Rule

On this next panel we will specify the Rule to use for this job.

If the panel indicates that only "Delete" and "Skip" Rules are available,
you have selected only one root path. You should use the "Back" button
to return to the root path entry panel and add your other root path(s).

The type of Rule we will be using in this example is "Archive".
3 Rule Wizard for Archive to JEFFTEST = —

Rule Type

What synchronization method do you want to use?

AICH
Delete
Skip

Copy file change and deletion everts to an Archive.

Click the "Next" button to continue.

Selecting Source and Destination

The next panel is where you indicate which root path is to be used as a source and which is to be
used as the archive destination. Only one path can be the source and the path(s) defined as an
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Archive path will only be listed as destinations. To complete this panel, simply check the source
path.

Your wizard panel should look like the one below:

ﬁ Rule Wizard for Archive to JEFFTEST ‘

Root Paths

Specify the source and destination root paths for this Rule. Subfolders and file masks
can be specified elsewhere. You cannot fitter rules by root path but if a rule applies, it
only affects the selected root paths.

Agent Name Source Root Path

JEFFKHP  C:\SalesData I
Agent Name Destination Root Path I
(4l Paths Except Source)

[C| (IJEFFTEST  C:\SalesDataArchive

<Back ||

Mext =

L

Filtering Subfolders

Lo |

The next panel in the wizard allows you to include or exclude specific subfolders. The default “\"
means to include all subfolders. You can enter subfolders into the text field or select them using
the checkboxes in the browse dialog on the lower portion of the wizard panel. Folders are

excluded by placing a minus character (-) in front of the folder name. Multiple folder entries are
separated by the vertical bar character ().

3 Rule Wizard for Archive to JEFFTEST ‘

Subfolders

Select one or more subfolders from any root path. Separate subfolders with vertical bar
characters {J. Subfolder values nomally start and end with a backslash.

[JEFFK-HPF] C!\SalesData
[JEFFTEST] C:\SalesDatalrchive

Also apply Rule to subfold

of the folders ifi

d

L

< Back

I

Mext =

Cancel ]‘[L

Examples

To archive only two subfolders named FolderA and FolderB, you would enter the following:

\FolderA\ | \FolderB\
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To archive all subdirectories except for subfolders FolderA and FolderB, you would enter the
following:

\ | -\\FolderA\ | -\FolderB\
The archive job in our example will be using the default “\” setting to include all subfolders.
To learn more about how to include and exclude subfolders press the F1 key on this panel.

Filtering Based on File Masks

The next panel displayed will let you indicate the files to be included or excluded from the job.
Each entry in this panel should be separated by a vertical bar (|) character. To exclude a file
name or file type place a minus sign (-) in front of the mask.

Rule Wizard for Archive to JEFFTEST BN

File Masks

File masks that must be present for this rule to apply

=2 tmp | -"doc | -~8 doc? | -5 xs?

Separate file masks with vertical bar characters (|). File masks may include standard
wildcard characters and can be preceeded with a hyphen ( - ) to exclude matching files
from the rule. These file masks do not affect the selection of folders. Press F1 for more
help.

Cancel | | < Back |[ Mext =

Examples

To archive only *.doc files and a file named Test.txt, you would enter the following:

*.doc | Test.txt

To exclude *.tmp files, *.doc files, and a file named Test.txt, you would enter the following:
-*.tmp | -*.doc | -Test.txt

The default setting for this panel is *.* | -*.tmp | -~*.doc | -~$.doc? | -~$.xIs?. This tells SureSync
to archive all files except *.tmp files and some commonly used Microsoft Office programs

temporary files. This is the setting we will use for this example.

To learn more about how to include and exclude files based on file masks press the F1 key on
this panel.

Clicking the “Finish” button will create your Relation. The Relation Wizard only displays a subset
of essential options for a Relation. There are many other options which can be configured by
modifying the properties of the Relation using the SureSync Desktop. Pressing the F1 key on any
tab in the application will display context sensitive help detailing the options on that tab.
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Previewing Your Relation

Once the Relation has been created, SureSync will prompt you to preview the newly created
Relation. The preview displays the actions that SureSync would perform without actually doing
them. This is a great way to determine if your Relation will perform as expected. You should
always preview a Relation after making changes.

When prompted to preview, click on the "Yes" button.

There are different displays available for the preview by selecting options under the "View" menu.
Please consult the SureSync Help File for more information about the preview window.

You may browse through the folders in this window to see how your files will be affected. A
legend can be accessed from the “Help” menu by selecting “Legend”. This will detail what the
various preview icons mean.

When you are done with the preview, close the preview window. This will take no action. You can
also click the Run button to run the current job from the Preview.

SPIAgent Compression & Encryption

The SPIAgent Add-On also provides the ability to compress and encrypt data during the
transmission. This functionality is very useful when dealing with slow lines or public lines like the
open Internet. For example, if you are synchronizing over the Internet, turning compression and
encryption on is recommended. This minimizes bandwidth consumption and secures the data
stream that is being transmitted.

If you want to enable compression and/or encryption, simply click on the Performance tab of the
Relation and check the “Use Compression” and “Encrypt Data” checkboxes.

l i Relation Sales Data

Execution and Metwork Priorty | (Default) lzl

Use Compression
| Use CRC to validate gpen file copies
Use CRC to validate all file copies
Encrypt data
Allow use of Delta Processing on non-lecal drives

V| Use database history for multi-way Rules
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Creating a Real-Time Monitor

A Real-Time Monitor is used in place of a Schedule to constantly monitor changes in files. When
a change is detected, the associated Relation/Rule is applied, and archiving is immediately
performed.

The real-time feature requires the use of the optional SPIAgent component on each machine
involved in the real-time monitor. A SPIAgent license is also required for the local machine that
will be running the job (if that machine is involved in the job).

In this example, we will create a Real-Time Monitor to process changes to our Relation as they
occur.

A Relation can only be running in one instance at a given time. If you
are planning to run a Relation with a Real-Time Monitor then you should
not attempt to run a Schedule of that same Relation at the same time.
You will get errors about the Relation already being busy. If a Schedule
exists to run a Relation you are going to run with a Real-Time Monitor, it
should be placed on hold or deleted.

To begin configuring your Real-Time Monitor, go to the File menu, select New, and then Monitor.

The wizards are designed to quickly and easily configure the basic
options needed to get a Real-Time Monitor up and running. SureSync is
an extremely flexible product with many advanced options. Additional
options can be specified on the properties panels for the Real-Time
Monitor after it has been created.

Name Your Monitor

r 3
B3 Monitor Wizard l = &J

Monitor Name

‘fou use a Monitor to package one or more Relations into a job. This job remains unning,
monitoring file and folder changes. Intervals can be used to control when files are actually
copied

Specify a unigue name for your Monitor

Archive to JEFFTEST]|

Describe this Monitor {optional)

Cancel < Back

The first panel allows you to name your Real-Time Monitor. Enter the name of the Real-Time
Monitor and an optional description, then click “Next” to continue.
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Selecting What Relation(s) to Run

The next panel is where you specify which Relation you would like this Real-Time Monitor to run.
Specify these Relations by checking the box next to their name. You can run multiple Relations
under one Real-Time Monitor.

ﬁ Monitor Wizard l = |

Relations used by Monitor

Relations with root paths being monitored
[Fd] Archive to JEFFTEST

[=] Multi-Mimor

[] SureSync 6 Peformance Tests

[ Cancel |[ <Back |[ Finisn |

Click the “Finish” button to create the Real-Time Monitor.

Modifying and Running Your Real-Time Monitor

When the wizard is complete, you will be returned to the SureSync desktop and the Real-Time
Monitor you created will be displayed.

You can make changes to the options for your Real-Time Monitor in the main SureSync window
by first clicking on the Real-Time monitor you wish to modify. You can then look through the tabs
on the right side for options to change. Pressing “F1” while on any tab will bring up context
sensitive help describing the options in detail.

Now that the Real-Time Monitor is created, it may be started by right-clicking on the Real-Time
Monitor name and clicking "Start Monitor." You may also uncheck the box that says "Stop Monitor
and place it on hold" on the General tab of the Real-Time Monitor. Then click apply to start the
Real-Time Monitor. Next to the Real-Time Monitor name will be the message "Waiting to start,"
which will change to "Active" automatically after a few moments.

Configuring E-mail Alerts

E-mail alerts can be a useful way of notifying the SureSync administrator of a problem which
should be investigated.

Configuring a SMTP Profile

To start the configuration of alerts, you must launch the SPIAgent Configuration utility and create
a SMTP profile. The SMTP profile provides SureSync with the necessary details about your
SMTP e-mail server so the program can send messages to you.
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To launch the SPIAgent Configuration utility, open SureSync, go to the “Tools” menu and select

“Alert user list..

1 SPI Alert Configuration

-

] |-

Eile Alert Users SMTP Profiles Help
: i| SMTP Profies |

User Name

| E-Mail Address

| Mail Profile

A

To create a SMTP Profile, go to the SMTP Profiles menu and select “Add New SMTP Profile...”

[ |
1 Add SMTP Profile =HECIN X
Profile Name | STMP Server
SMTP Server | smip.domain.com
SMTP Port 25
Sender Name | SureSync Admin
Sender Address | suresync@domain.com
Reply Address | suresync@domain.com
SMTP Server Authentication
User Name | username
Password | =
Confirm Password | =
[ concat |[ ok |
)

The “Add SMTP Profile” panel allows you to define the SMTP settings for your mail server. The
following fields must be configured:

e Profile Name: The name of the profile that you are configuring. For example, you might
use the name of the SMTP server.

e SMTP Server: The server address of the SMTP server. For example, smtp.mail.com.

e SMTP Port: The SMTP port for the SMTP server. The default SMTP port is 25.

e Sender Name: The name that will appear in the From: field of messages sent by
SureSync.

e Sender Address: The e-mail address that will appear on messages sent by SureSync.

o Reply Address: The reply address that will appear on messages sent by SureSync.

You can also define SMTP Server Authentication settings if your SMTP server requires a valid
logon to send messages. (most do) The following fields can optionally be configured:

e User Name: The username that SureSync will log into this SMTP server with when
sending an e-mail alert.

e Password: The password for the username defined in "User Name" should be entered
here.
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e Confirm Password: The password for the username defined in "User Name" should be
confirmed here.

Click “OK” to create the SMTP Profile. Clicking on the SMTP Profile tab of the SPIAlert
Configuration Utility will show the new profile.

| SPIAlert Configuration =HECE X

File Alert Users SMTP Profiles Help
Alert Users |5

Prafile Name | SMTP Server | Port | Sender Name | Sender Address | Reply Address |
STMP Server smtp domain... 25 SureSync A suresync@do...  suresync@d...

:]

Confiquring an Alert User

The second part of configuring E-mail Alerts is to define an Alert User. The Alert User defines the
e-mail address(s) that will be sent messages when errors occur. To configure an Alert User, click
on the “Alert Users” menu and select “Add User...”

.|

| Add User to Alert o e

User Name
Support Team
E-Mail Address
user@domain.com user 1 @domain.com user? @domain.co
Mail Profile Name
|STMP Server |

[ cancel | [ ok |

Zi

The “Add User to Alert” field has the following fields to be configured:

e User Name: The username that will be used in SureSync to represent this e-mail
address.

e E-mail Address: The e-mail address that SureSync will send the alert messages to.

e Mail Profile Name: The SMTP profile that will be used to send the message.

Multiple e-mail addresses can be added by separating the addresses
with commas (,) or semi-colons (;). This allows you to easily send
messages to a group of SureSync administrators.

Confiquring the Real-Time Monitor to Send Alerts

The final step of the alerts configuration is to tell the Real-Time Monitor to use the Alert User and
at what level of errors to send alerts. This is accomplished by clicking on the Real-Time Monitor in
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the SureSync desktop, clicking on the Alerts tab, selecting the Alert User from the drop-down
menu, and then clicking “Apply”.

- Menitor Sales Data

Alerts

Specify a user to receive an e-mail alert if a job encounters emors.

Userto Aledt | Support Team E‘

Alert Level | 3-Warnings, Job Failures, and Severe E‘

Alert Users...

Additional details about the E-mail Alert levels available can be found by pressing “F1” while on
the Alerts tab.

Monitoring the Archive Job

Monitoring your archive job is important, and SureSync makes this process easy through the use
of two different status panels.

Detailed Status

The detailed status panel will show you file level activity for a current job as well as common
counters such as files added and files deleted. If you want to take an in-depth look at a particular
job, you will want to use Detailed Status.

To launch Detailed Status, right click on the job and select “Job Status.” You can also select the
job and then go to the “View” menu and select “View Job Status.”
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= SureSync Detailed Job Status

Actions

WLE?

Server Name 9PGGCG1-JEFFK .
Job Name BlendedStructure to NETTEST
Falder being examined \Gordon\QA Traces for issue 360143\Tovatest (remote)l
Waiting for tasks to complete.
170 Files Scanned 120 Added 0 Exceptions 101.2MB Copied
0 Journal Events 0 Replaced 0 Errors 79 % Transmission Savings
4 Active Actions 0 Removed
52 Actions Queued 0 Altered 00:00:23 Elapsed
File Name Action Bytes Copied % Complete Duration Lockouts Locking User Source Folder
SureSync2008.exe Copy 175MB of 543.2MB 3% 00:00:03 0 [local agent]ChSureSync 6 Pe
Session-08082% 08-4%.lo  Copy 413KB of 413KB 100% 00:00:00 0 [lacal agent]ChSureSync & Pe
SyncFiles-08082% 08-49. Copy 1.7MB of L7TMB 100% 00:00:00 0 [local agent]ChSureSync 6 Py
Srv-DM5ecsion-080829 ¢ Copy 892KB of 892KB 100% 00:00:00 0 [local agent]CASureSyne 6 Py
[ " ] v [
— E

Enterprise Status

The Enterprise Status panel can be used to view the current status of jobs from SureSync
installations anywhere on your network. To see detailed status, you can launch the Detailed
Status panel for a particular job right from the Enterprise Status application. The Enterprise
Status panel provides an easy way to stay current on the status of your jobs, no matter where
they are running.

Enterprise Status can be launched by going to the Start menu, selecting SureSync and then
“SureSync Enterprise Status”. You can also click on the “View” menu and select “Enterprise
Status” or click on the “Enterprise Status” button in the menu bar.

=} SureSync Enterprise Status _- ‘ @E‘QW

Actions
S50 7
Click on the bar below to display status in greups. Click on column names to sort and hold Ctrl to sort on additional columns.

I

®| MonitorHeld (4 items)

| MenitorRunning (5 items)

Scheduler . Job Name Errors Exceptions Added Replaced Bytes Copied Deleted Altered Scanned

NAS3 . Real-Time Archiving 1 ] 86 54 28.6M8B 163 7 6,041
MNAS3 ' Monitor Mirrors 0 0 0 1 231KB 2 0 10,025
SPIWEBSVR . Mirror Archive to ArchiveBackupl (1) 0 0 111 0 2.2GB 1,068 0 14,006
SPIWEBSVR ' Mirror Archive to ArchiveBackup? (1) (1] [} 70 1] 1.5GB 644 (1] 14111
SPIWEBSVR ' Real-Time Archiving 0 [} [} (1] 0KB 0 0 0

| ScheduleHeld (6 items)
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